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Purpose

This application note demonstrates how to build single and multiple SoftConsole application executable
images in the production release mode, store them into embedded non-volatile memary. (eNVM) using
eNVM data storage client, and execute them on SmartFusion®2 system-on-chip .(SoC) field
programmable gate array (FPGA) Security Evaluation Kit.

Introduction

SmartFusion2 SoC FPGA devices have a maximum of two on chip 256 KB flash memories called eNVM.
The eNVM is used to store the application code executable image or store data, which is used by the
user application. Refer to the eNVM chapter of the UG0331: SmartFusion2 Microcontroller Subsystem
User Guide for a detailed description about eNVM.

The user application projects are built in Release/Debug mode for execution on SmartFusion2 Security
Evaluation Kit through SoftConsole. In the Debug mode, the complete symbolic debug information is
emitted to the debugging applications and the code is not optimized. In the Release mode, the complete
symbolic debug information is not emitted and the code execution is optimized. The size of the final
release mode executable is smaller than the debug-executable. It also runs faster than the debug mode.

This application note describes the following:

* How to build a single SoftConsole application executable image in production release mode, store
the image into eNVM using eNVM data storage client, and execute the image directly from eNVM
of the SmartFusion2 Security Evaluation Kit.

A sample SoftConsole application project fetches factorial of a number from a non-executable
image (LookUpTable.hex) stored.in eNVM. LookUpTable.hex file contains pre-calculated factorial
values. For more information about how to create a LookUpTable.Hex file, see "Appendix B:
Creating LookUpTable.Hex File" on page 46.

* How to build'multiple SoftConsole application executable images in production release mode and
store theminto eNVM using eNVM data storage client.

The SoftConsole application projects show how the stored executable images in eNVM directly
runs from eNVM, and how to remap the images to run from eSRAM. The SoftConsole application
projects designed here are to blink LED on the SmartFusion2 Security Evaluation Kit.

To demonstrate the above two scenarios, two design folders with the SoftConsole application projects
are provided with this application note in "Appendix A: Design and Programming Files" on page 45.

References

The following list of references is used in this document:
*  UGO0331: SmartFusion2 Microcontroller Subsystem User Guide
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Design Requirements

Table 1 lists the design requirements.
Table 1« Design Requirements

Design Requirements Description

Hardware Requirements

SmartFusion2 Security Evaluation Kit: Rev D or later
* 12V adapter (provided along with the kit)

* FlashPro4 programmer (provided along with the kit)
* USB A to Mini-B cable

Host PC or Laptop Any 64-bit Windows Operating System
Software Requirements

Libero® System-on-Chip (SoC) v11.6

SoftConsole 3.4 SP1

Host PC Drivers (provided along with the design files) USB to UART drivers

One of the following serial terminal emulation programs: -
* HyperTerminal
*  TeraTerm

* PuTTY

Building Executable Image in Release Mode

The following steps describe how to build an application executable image in the release mode:
1. Open the standalone SoftConsole IDE.

SC C/C++ - Welcome to Microsemi SoftConsol
File Edit Source Refactor Navigate S

7 @~ e
(25 Project Explorer 52 = O[5 Welcome £3
= % 7| Microsemi SoftConsole IDE v3.4

el JETDE 34 m— e [E=Eo >
Project Run Window Help

B0

‘Add an initial source file with File > New > Sourcé File

H Add code tojtand eick the Build All icon

5 Additional Information
* Release Notes

* Onlire documentation

21 Problems 57 Tasks| B Console| I Properties T
0items

Description B Resource Path Location  Type

Figure 1 » SoftConsole IDE
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2. Right-click the Project Explorer window and choose Import as shown in Figure 2.

SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 -
File

ie IDE v34 — T—
Edit Source Refactor Navigate Search Project Run Window Help

o
i~ y B B -G iR B -0 Q- B
(7 Project xporer &3 = 0B Welcome 52

w ETes)
= % 7| Microsemi SoftConsole IDE v3.4

= O[5 outii 2\ @ Mak | T O

SoftConsole is  free software development environment
enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConsole:
letsyou diately compiled into 2 usable binary.

‘An outline i not available.

S Starta Project
To begin your work, click File > New > C Project
Give your project a name, and select a toolchain if you are going t

be compiling for a target other than the default choice of the Microsemi Cortex-M3.
“Then click Finish.

‘Add an initialsource file with File > New > Source File

Add codeto it and click the Build Allicon.

5 Existing Code:
You can also imj
File > Import..
and click
General > File System

port an edsting source tree using

5 Additional Information
* Release Notes

* Online documentation

[2 Problems 2 ] Tasks| Bl Console| = Properties|

A < —
L ,
nd 0 items selected
Figure 2  SoftConsole IDE - Import
3. Select General > Existing Projects into Workspace as shown in Figure 3.
SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsemi SoftConsole IDE v3.4 — - - = =
(=i ? E-68-E -G~ 8-8- $-0-%- &~ A F-man - s
[ Project Explorer 53 = T[[E Welcome 53 = 05 outl 22 @ Mak | = O
= % 7| Microsemi SoftConsole IDE v3.4 ScEineE ot
s o Select \
SrtaPrlect xcick Fie> News,CEl Creste new prjects from an achive il r directory ¥
4 (= General
'L Existing Projects into Workspace
(5, File System
Dptngde  ing ot = petences
A & o
H
© naatsons o G
@ ok Net> =
[2 Problems 2 ] Tasks| B Console| = Properties| v =0

Location  Type

14 0 items selected

Figure 3 » SoftConsole IDE - Importing Existing Projects
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Import window is displayed as shown in Figure 4

SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsem SoftConsole IDE v3.4

— — —_— = o
Fie £t Souce Refactor Navigste Search Project Run Window Help
mhe s E B @G RS B0 A @ B v fl v ey & [{@acs)
[ Project Explorer 23 = O)(B Welcome 2 \_ = OBz outi X\ @Mak | = O
= % 7| Microsemi SoftConsole IDE v3.4 A catine = not avarlabic
SoftConsole s a free software development environment

enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConsole:
lets you write software that is immediately compiled into a usable binary.

¢ import [T

. Import Projects
P
Give your project a name, and select a toolchain if you are going to <

“Then click Finish.

elect roo directory: Browse.

‘Add an initialsource file with File > New > Source File eI

Add code o, and clickthe Build Al con, A
Select All
® bisting Code
You can lso import an exiting source ree using Deseect Al
Fle > Import..

and click

) Additional Information
* Release Notes

* Online documentation (] Copy projects into workspace

Working sets
7)Add project to working sets

Warking sets Select.

®

[ Problems 52 & Tasks| B Console| I Propertes| e
0items
Descrption B Resource Path Location Type

o 0items selected

Figure 4 * SoftConsole IDE - Browse

File

€t Source Refactor Navigste Search Project Run Window Help
=he 9 sig- 8- E-G- i8-8 $-0-A-®dP-E 81 - 51 - - - 5(Ee)
[ Project Explorer 23 = O)(B Welcome 2 \_ = OBz outi X\ @Mak | = O
= % 7| Microsemi SoftConsole IDE v3.4 A catine = not avarlabic
SoftConsole s a free software development environment
ensbling the rapid producton of C and Ce- executablesfor processors
svailable for use in Microsemi devices. Creating s project nside SoftConsole
letsyou write software that i immeditely compiled into a usable bina
% VEDES 2y SC Import a] = |
< Import Projects
 Starta Project
ot Selecta directory to search for xsting Eclpse projects
Give your project a name, and select a toolchain if 4
be compiling for s target other than the Mi q -
Then click Finish. elect root directory:
Add anintal source file with Fle > New > Source File T -
Add code tot,and click the Build Aflicon, - W e——— ™)
Select root drecory of the projects o mpart
5 Existing Code
Vou can skso import an exsting ource tre using
e~ Inport.. 48, Local Disk (C) &
General > File System P s Dell
o0 dir
4L eNVM DatsClient
%) AdditionalInformation > 0 component
* Release Notes L
5 0l constrsint =
* Online documentation 9] Copy projd| b designer
Working se] > UL frmware
ha
[E1Add prof)|
). simulation
Working +d B amatgen
4L SoftConsole
4111 eNVM_DataClient MSS_CM3
projects
). metadata
@ » )L eNVM_DataClient_MSS_CM3._app
1 eNVM_DstaClient_MSS_CM3_hwi_pltiorm
)i stimulus
UL synthesis
(21 Problems 57 Tasks| EJ Console| I Propertes| iicoiiE 2 Y=
‘ y
0 items. { |
Description B Resource Path U Foder:  projects
0° Oitemsselected

Figure 5 » SoftConsole IDE - Browsing for Projects Folder
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4. Ensure that Copy projects into workspace check box is checked as shown in Figure 6. Click
Finish.

SC Import

Import Projects

Select a directory to search for existing Eclipse projects.

Ny

(@) Select root directory:  C\eNVM_DataClient\SoftConsoleleMVM_Datat Browse...
() Select archive file: Browse...
Projects:

eMVM_DataClient_MS5_CM3_app (C:heNVM_DataClient\SoftCons Select All
eMNVM_DataClient_MS5_CM3_hw_platform (CheNVM_DataClient.!
Deselect All

Refresh

4 | i | b

Copy projects into workspace
Working sets

[] Add project to working sets

Select...

N &

@ [ <Back |~ Neas [ Fmsh [ Cancel

Figure 6  SoftConsole IDE - Creating Work Space in App Folder
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The SoftConsole perspective is shown in Figure 7.

o . )
- B (@)

$C (/s - NVMLDstaCHar NS, sppmain - Wirsar SofiComsae €34

Ele Edit Source Refactor Navigate Search Project Bun Window Help

NEHSIR 9IS @-8-E-6r R0 -i%-0-Q- -

5 Project Explorer 23 B %~ 0)(meine i3 2 Mak | = 0
5 eNVM_DataClient_MSS_CM3_spp 67/ B AR o kT
(i) Includes Geint main() o m2sech
3 mainc 69t 2 drivers/ms_uart/mss._ui
5 eNVM_DataClient_MSS_CM3_hw_pltform uince_t rx buff(ll: # ENVM_DEMO_IMAGE.S
7. unsigned long data; oy
it i o printnumber(in): nt
7 /* Initialization all necessary hardware components * o UART:Polied Reimetia
75 MSS_UART init( eg mss_uarcl,MSS UART 57600 BAUD,MSS_UART DATA 8 BITS | MSS_UART NO_PARITY | MSS_UART_ONE_SIOP_BIT ) 8} nanl; o6
75 MSS_UART polled tx (69_mes_uaiacroBpamson] ") "$### Welcome to SmartFusion2 $7Ff\n\r",sizeof ("$##f Welcome to SmartFusion2 FFF\R\Z")):
18 ls7600
77 while(n) press 2 forfocu
7t
7 MSS_UART polled tx(sg_mss_uarcl, (sincs_c *)"Please Select the Following optionm\n\r",sizeof ("Please Select the Following opriom\m\z"))s
MSS_UART polled tx(sg_mss uarcl, (sints t *)"1.Factorial of 2\m\z",sizeof ("1.Factorial of 2\m\z")); L
MSS_UART polled tx(sg_mss uarcl, (sint® ¢ *)"2.Factorial of 3\m\z",sizeof("2.Factorial of 3\m\z")); 1
MSS_UART polled tx(sg_mss uarcl, (sints T *)"3.Factorial of 4\m\z",sizeof ("3.Factorial of £\m\z"));
while( (! (VART_Polled Rx ( &g_mss_uarti, rx buff, 1))) )
data = *(ansigned int *)ENVM_DEMO_IMAGE_STORED_ADDR:
byce[s] = data & OxFE; / -
i B — ' < [N v

(21 Problems |2 Tasks | ] Console 53 (] Propertes| @ B> 5 - =0

C-Build [eNVM_DataClient_MSS_CM3_app]

Wiitable Smartlnsert | 74:41

Figure 7 * SoftConsole Workspace

5. Right-click both the project namesin the Project Explorer view and select
Build Configurations > Set Active > Release as shown in Figure 8.

SC C/C++ - eNVM _DataClient app/mai Con
File Edit Source Refactor Navigate Search Project Run Window Help

Y S & E)

(w2 Bi9isa @ -8-F-6- K-8 %-0 - ™5 SF
[ Project Explorer 23 B % ° = 0B minc 2 = OBz outi 2\ @Mak | = O
& / 9 B R o %Y
2int main() U m2soxh
New vk
R x 2 drivers/mss_uart/mss_u;
. uince_t rxdBREELL1F & B
= . o printnumber(int) s int
&) Comy S 7 e ot ©  UART Polled_Re(mss_uz
Paste Culev 8 i S
uSSOUART init( &g_mss_uartd,MSS UART_57600_BAUD,MSS_UART DATA & BITS | MSS_UART_NO_PARITY | MSS_UART ONE_STOP_BIT ): o main s
X Delete Delete M85 UART polled tx (&g mss_$ased, (uinté_t *)"#### Welcome to SmarcFusion2 ####\n\r",sizeof ("#### Welcome to SmartFusion2 ####\n\z"));
Move.
Rename. 3 while(@)
t
a5 Import. MSS_UART pblled tx (sgfiss uartl, (uints t *)"Please Select the Following option\n\r",sizeof ("Please Select the Following optiom\m\z")): A
iy S5 UART_pellearcx(dg mes uercl, (uincé t %)"1.Factorial of 2\n\z",sizeof ("l.Factorial of 2\m\z")):
1SS UART pelled tx(sg mss_uercl, (uincé t %)"2.Factorial of 3\n\z",sizeof ("2.Factorial of \m\z")); =
Build Project MSS_UART polled ti(sg_mss_usrcl, (wincé t %)"3.Factorial of S\n\z",sizeof ("3.Factorial of \m\z"));
Clean Project
Wwhile( (! (UART_Polled Bx ( &g_mss_uartl, rx buff, 1))) )
&1 Refresh 5 % - = e =
Close Project

R - i data = #(unsigned int ¥)ENVM_DEMO_IMAGE_STORED_ADDR;

Eanarh fyce(3) = aaca ¢ oxer; /+ 0 -7 - 4
Build Configurations Sl ST 10w oo Y | —m— 5
Moke Torgets v e »|[V] 2Relesse = —
9 £ I @t BE-r9--0
Index N T
i e | =
Release for preject eNV_DataClient_MSS_CHS_app *+++
Run s , 8 HSS_CH3._
Debug As » forean
Profic As s |2 /e pavaciient_ss_c¥s_app.map
- . |c memory-map.xmi /main.c ./main.d eNVM DataClinc MSS_CM_spp.srec SNV DataClisnc MSS_CMO_spp.hex  eNVM DavaClient MSS_CMS_spp.lst eNVH_DstaClient MSS_CHS_app
DacaCiiens ss, QH3_app
Compare Wi ,

RestorefiamLoeal Hitory.

1} 1 2 items selected

Figure 8 » Building Configurations
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6. Go to Project > Build All and Build the project as shown in Figure 9. . hex file is generated in the
Release folder (see Figure 10 and Figure 11 on page 11).

SC C/C++ - eNVM_DataClient MSS_CM3_app/mainc - Nicrosem SoRCORsOIe IDEVEA I T RTT— — | O )

Fie it Sorce Rfactor Novgte Surch [Pt Run Wi i
e o o)

- |G 9 inig-6s| OpenProject EPE P - .
Close Project
Ol o b = (82 outi 5\ © Mak | = O
" 5 eNVM_DataCient VS5 CV_spp & BuldAl culee 7 = AR o %
+ £ eNVM_DataClient MSS_CMB._hw_plstform| | Build Configurat » b T
Build Project U drivrs/mes_usrt/mss
ot rx pusz(il; e
Build Working Set o | i # BEMDRORIGS
Clean. ied int byte[4]; L
B e Al . cand © UART_Polled_Rx(mss_ua
Y UART_: \:L &g_mss_uartl,’ uss, _UART_57600 BAUD MSS_UART_DATA_8 BITS | MSS_UART_NO_PARITY | MSS_UART_ONE_STOP_BIT ): @ {main(}int;
Make Target » [UART pnlled tx(8g_mss_uartl, (uints_t *)"#### Welcome to SmartFusion2 #3##\n\r",sizeof ("#### Welcome to SmartFusion2 $###\m\z")):
Properies 20
T
MSS_UART polled tx (&g_mss_uartl, (uints t *)"Please Select the Following option\n\r",sizeof ("Please Select the Following optiom\m\z")); M
155 UART polled t (69 mss Wartl, (uinte t %) "1.Factorial of 2\n\r",sizeof ("l.Factorial of 2\a\r")):
155 UART polled tx (69 mss Wartl, (uinte t +)"2.Factorial of S\n\r',sizeof ("2.Factorial of S\m\r")); =
155 UART polled tx (69 mss Wartl, (uinte t +)"3.Factorial of §\n\r',sizeof ("s.Factorial of £\m\r"));
while( (!(UART_Polled Rx ( &g_mss_uartl, rx buff, 1))) )
data = *(unsigned int *)ENVH DEMO_DMAGE_STORED_ADDR;
byte(s] = dsta ¢ OXEE: - N
A, « o ac . v < - E
[[EL Problems [ Tasks |l Console £ (5 Propertes| @G BE-r5-=0

C-Build [eNVM_DataClient_MSS_CM3_app]

%% Clean-only build of configuration Release for project eNVM DacaClienc MSS_CM3 app *++*

make clean
Im -rf ./eNVM DataClient MSS_CM3_app.map

m -rf memory-map.xml ./main.o ./main.d eNVM DataClient MSS_CM3_app.srec eNVM DataClient MSS_CM3_app.hex eNVM DataClient MSS CM3 &pp.1st eNVM_DataClient MSS_CM3_arp
eNVM_DataClient MSS_CM3_app

1} 1 2 items selected

Figure 9 « Build All

S C/C+ - NVM_Dotalen NS N opp/main~WiCeser SRESTEOIE OV ET—— T — s

s e o i Mt
- B i9is @8- E-6 & 8- % -0-Q 0 | 460 - ®@Te)
5 Project Explorer 23 B% "~ = 0|0 mainc X = OBz outi 2\ @Mak | = O

125 eNVM DataClient MSS_CM3_app 67/ 9 PSR
5 NUM_DataClient_MSS_CM3_.platform nt main() T

" : e
meigned 1ong date; # EWA DELD IMAGE S
2 o printnumber(int) : int
neidmed int byvel41s
e e ©® UART Polled_Rx(mss_ua

neceSgazy Merdvare componéRES *
MSS_UART_inic{JEGHss, uartl, MSS UART 57600_BAUD,MSS _UART DATA 8 BITS | MSS_UART_NO_PARITY | MSS_UART ONE_STOP BIT );
MSS_UART Polled tx (£ mas uarci, (uint8usem)#$#8# Welcome to SmarcFusion? $3##\n\r",sizeof ("#### Welcome to SmarcFusion? ####\n\r"));

© main:int

while (1)
i

MSS UART polled_tx (sg mes_arcl, (aincé_c *)"Please Select the Following option\n\z",sizeof ("Please Select the Following optiom\nm\r")):
MSS_URRT polled tx(ag_mss Harcl, (sints T *)"1.Factorial of 2\m\z",sizeof("1.Factorial of 2\m\z"));
WSS UART polled_tx (sg_mds_uarcl, (uints_t *)"2.Factorial of 3\m\z",sizeof ("2.Factorial of 3\m\z"));

MSS_UART_polled tx (sg_mss_warci, (wints_t *)"3.Factorial of 4\n\r",sizeof ("3.Factorial of 4\n\z"));

while (\(4(UARL_Polled(Rx ( &g mss_uartl, rx buff, 1))) )

data = *(unsigned int *)ENVM_DEMO_IMAGE_STORED_ADDR;

. . TEr

« - - D . c e - » " [ »
IR protiems [0 TN & opetic] =
63 NV DsdClient, MS5.CMB_opp]

ey “Tre e 3 FETE S5 G5 B - A
Cr e s Qts_tar p. o ace.1d -1, -Hap-eNV_Davaciienc HSS CHS app.map -Klinker -ge-sections
oot Dataciicnt 4SS Cus app"  -/main-o C:/eN I s/ S5 s o o R
3 1S5 a3/ eV DataClient HSS QM3 hw p v Stubs.o ~1eNVM DataClient MSS CHS w platfora

Finished building target: eNVH DataClicnt HSS CMS app’
Invoking: emory map genszater’
I R N s cus_app —_— specs
e e g “uiss s g .
BN s st pi. o ace.14 ~H1, Hap-elVi_DacaClienc_HSS_CHS_app.map ~Klinker -go-sections

Generated file memory-map.xml N
‘Finished building: memory-map.xml'

‘Invoking: GNU Intel Hex File Generator’
arm-none-eabi-objcopy -O inex eNVM DataClient MSS_CM3_app "eNVM DacaClient MSS_CM3_app.hex"
‘Finished building: eNVM DacaClient MSS_CM3_app.hex’

| Invoking: GNU S-Record Generator®
arm-none-sabi-objcopy -0 srec SNV DacaClient sk CUS_app "eMV DataClient MSS_CH3_app.srec”
Fintshed building: SNV DacaClient MSS CH3 app.szect

'Invoking: GNU Listing Generator'
arm-none-eabi-objdump -h -5 eNVM_DataClient MSS_CM3_app > "eNVM DacaClienc MSS_CM3_app.lst’
‘Finished building: eNVM DacaClient _MSS_CM3_app.lst’

Figure 10 » Generating Hex File
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g i 5
- -
@u'| K - ] 3 | | Search Release pe |
Organize = Include in library « Share with » Burn MNew folder =« [ l@l
S Favorites * MName - Date modified Type Size
Ml Desktop | eNVM_DataClient_MSS_CM3_app 2/9/201511:47 AM  File 128 KB
4. Downloads = eNVM_DataClient_MS5_CM3_app 2/9/201511:47 AM HEX File 13 KB
=] Recent Places | eNVM_DataClient_MS5_CM3_app.lst 2/9/201511:47 AM L5T File 106 KB
|| eNVM_DataClient_MSS_CM3_app.map 2/9/201511:47 AM  MAP File 54 KB
- Libraries = L eNVM_DataClient_MS5_CM3_app.srec 2/9/2015 11:47 AM SREC File 13 KB
3 Documents L main.d 2/9/201511:47 AM D File 1KB
J‘. Music || main.o 2/9/201511:47 AM O File 3KB
=/ Pictures | makefile 2/9/201511:47 AM  File 3KB
E Videos =] memory-map 2/9/201511:47 AM XML Document 1KB
= L ohjects.mk 2/9/201511:39 AM ME File 1KB
18 Computer | sources.mk 2/9/2015 11:47 AM ME File 2KB
5_'7, Local Disk (C:) | subdirmk 2/9/201511:47 AM MK File 3KB
—a New Volume (D) ~
) 12 items
W ~— —

Figure 11 « Hex File in Release Folder

Loading the Executable Image into eNVM

The following steps describe how to load the generated executable image into eNVM of the

SmartFusion2 device using the System BuildereNVM Configurator:

1. Open the Libero SoC hardware project eNVM_DataClient_top tab, see Figure 12.

Project  File Edit

NEW=22™ 0

Design Flow

View Design Tools SmartDesign Help

53 ehivm_Dataclisht_top™ X | Reports & X | startpage & x|

NVM_DataClient_top

E'ﬂp@m‘noboﬁo QafHaE ANDO

Tool
W <+ » CreateDesign
& System Builder
v & Configure MSS
B3 Create SmartDesign
Create HDL eNVM_DataClient_0
2 Create SmartDesign Testbench Comsrap TROSESTN rovmotrecipX
Create HDL Testbench NES_READY X
4 b Verify Pre-SynthesizegDesign
B simulate
4} Create/Constraints
+E1/0 Constraints
4 D) Timing Constraints
@) synthesis\eNVMDataClient_top_sde.sde
B Floorplan Censtraints

Desion

m

L__a ¥

ZIMDDR_FAD5

m

DesignFlow | Design Hierarchy | Stimulus Hierarchy | Catalog | Files |

n

Log

Q@ Erors 4 Warnings 4 Info

Project closed.
The 'close_project' command succeeded.
The Execute Script command succeeded.

Info: 'eNVM DataClient top' was successfully generated.

Info:

log | Message

"elVM DataClient top' manifest file 'C:/eNVM DataClient/component/work/eNVM DataClient top/eNVM DataClient top manifest.txt' was successfully generated.

Fam: SmartFusion2 | Die: M25090T |Pkg: 484 FBGA |Verilog

Figure 12 « eNVM_DataClient_top Tab

2. Double-click eNVM_DataClient_0 and go to System Builder - Memories page to add the eNVM

Data Storage client, see Figure 12.
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3. Select Data Storage under Available Client Types tab and click Add to System..., see
Figure 13. This opens Add to Data Storage Client window as shown in Figure 14-

'@ System Builder - Memories - T — R— — uﬂﬂ‘
> Device Features » 7 Memories » » Peripherals » ) Clocks » > Microcontroller SECDED > Security »» Interrupts ) > Memory Maj
Configure your external and embedded memories
[ MDDR \/ ENVM \
L EEaE ZLTE User Clients in eNVM
Data Storage
Serialization Chent Type l Client Name: DepthxWidth I Start Address(Hex) Page Start I Page End Initialization Ordér Lock Start £
Usage Statistics
Available Pages: 2032
Used Pages: 1]
Free Pages: 2032
‘ " v v
Hext
L

Figure 13 * System Builder - Memories Page

Revision 4



& Microsemi

Implementing Production Release Mode Programming for SmartFusion2 - Libero SoC v11.6

5| Add Data Storage Client

2 [z |

Client name:
eMVM
Content:

@ Memory file:

Format:

[] use absclute addressing o
() Content filed with 0s

(7 No Content {Client is a placeholder)

Start address: 0x 0 =
Size of word: bits
Mumber of Words: 1 (decimal)

|:| Use as ROM o

|| use Content for Simulation

.

F— = g R Se——" ———

Figure 14 « Add Data Storage Client Window
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4. Enter a data storage client name in the Add to Data Storage Client window.

i . T TR RN TE— 3
@ Modify Data Storage Client l D |l
Client name:  Main_App|
eNVM
@ Content from file:  |MSS_CM3_app/Release /eMVM_DataClient_MSS_CM3_app.hex E
Format: |IntelHex hd
[ Use absolute addressing 6
) Content filled with 0s
) Mo content (dient is a placeholder and will not be programmed)
Start address: 0x 0 =
Size of word: Bits
Number of words: 4532 Decimal
[CJuseasrom
[ use content for simulation
Help QK ] l Cancel
L

Figure 15 « Add Data Storage Client Window

5. Browse for the .hex file generated in the SoftConsole project after building an executable image
in the' Release Mode. The generated executable image is in the Release folder under
SoftConsole project workspace, see Figure 16 on page 15 and Figure 17 on page 15.
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‘ NC:\eNVM_DataClient\SoftConsoleleNVM_DataClient M
e —
Organize * Include in library = Share with = Burn Mew folder
¥ Favorites * Name . Date modified Type Size
M Desktop || eNVM_DataClient_MSS_CM3_app 30-09-2015 11:38 File 128 KB
& Downloads || eNVM_DataClient_MSS_CM3_app.hex 30-09-201511:38 HEX File 13KB
%] Recent Places || eNVM_DataClient_MS5_CM3_app.lst 30-09-201511:38 LST File 106 KB
| eNVM_DataClient_MS5_CM3_app.map 30-09-201511:38 MAP File 54 KB
4 Libraries £ | eNVM_DataClient_MS5_CM3_app.srec 30-09-201511:38 SREC File 13 KB
% Documents | main.d 30-09-201511:38 D File 1KB
& Music | main.o 30-09-201511:38 O File 3KE
[E] Pictures | makefile 30-09-2015 11:38 File 3KB
Subversion 2] memory-map 30-09-201511:38 XML Document 1KB
B# videos || objects.mk 30-09-201511:38 MK File 1KB
|| sources.mk 30-09-201511:38 MK File 2KB
18 Computer | subdir.mk 30-09-2015 11:38 MK File 3KB
&, Local Disk (C3)
) 12 items

Figure 16 » Executable Image in Release Folder

(@ vty i Serge oo T ——— . |

Client name:  Main_App|

eNVM {

@ Content from file: lMSS_CM 3_app/Release /eNVM_DataClignt_M55_CM3_app.hex | G

[] Use absolute addressing (3]

I () Content filed with 0s

() Mo content{dient is & placeholderand will not be programmed)

Starpaddress: . 0x o/ 2]

Size of word: Eits

| MNumber of words:> 4592 Dedmal

I ||E|UseasF‘.DM (1)

I Use content for simulation

Help [ OK I [ Cancel

—

Figure 17 » Add Data Storage Client Window
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6. Click Ok in the Add Data Storage Client window.
7. Add LookUpTable.hex file to eNVM Data Storage Client as shown in Figure 18 and Figure 19 on
page 17.
Note: The LookUpTable.hex file contains the pre-calculated data of the factorial of numbers 2, 3, and 4
(2, 6, and 24 in Hexa decimal format). This is a non-executable image and is stored in eNVM. The
factorial data is fetched by the Main application.

[ [ E ]
m‘ (SEC:\eMNVM_DataClient\SoftConsoleleMNVM_DataClient MS5_CM3\projects| Search projects pel
E——
Organize » Include in library Share with » Burn MNew folder =Gl @
¥k Favorites Mame ° Date modified Type Size
Pl Desktop . .metadata 30-09-201511:37 File folder
4 Downloads .. eMVM_DataClient_MS5_CM3_app 30-09-201511:37 File folder I
i:_‘.l Recent Places 1/ eMVM_DataClient MS5_CM3_hw_platform  30-09-201511:37 File folder
|_| LookUpTable.hex 18-06-2014 11:40 HEX File 1KB
4 Libraries
@ Documents
J’ Music
[&=] Pictures
=l Subversion
BB videos

18 Computer
& Local Disk (C:)

a Mew Volume (D:)

fj MNetwork

4 items

Figure 18 * LookUpTable.hex File
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8. Select the Start address as 20000 in the Add Data Storage Client window, see Figure 19. This is
the address in eNVM, where the LookUpTable.hex file is stored. Click Ok.

-
G\ Add Data Storage Client

TS SRR W S

=)

Client name:  LookUp_Table
eMVM
Content:

Format: |Intel-Hex hd

[7] Use absolute addressing e
() Content filed with Ds

() No Content (Client is a placeholder)

Start address: O0x 20000 5
Size of word: bits
Mumber of Words: 4 (decimal)

|:| Use as ROM 6

|| use Content for Simulation

Help

@ Memory file:  NVM_DataClient_MSS_CM3/projects/LookipTable. hex E

] l Cancel

Figure 19 » Add Data Storage Client Window
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9. In the System Builder - Memories page, keep the other settings to default and click Next, see

Figure 20.
—— L — - - T O W . v ..
@ System Builder - Memories =&
> Device Features Memories » > Peripherals » ; Clocks Microcontroller » ;  SECDED » 7 Security Interrupts » > Memory Map »
Configure your external and embedded memories
MDDR\/ ENVM '\
-
Avaiable Client types User Clients in eNVM P
Data Storage
Serialization Client Type Client Name DepthxWidth Start Address(Hex) Page Start Page End Initialization Order
1 |[® Datastorage Main_App 4592 % 8 0 0 35 NfA
— 2 |€¥ DataStorage look 4x8 20000 1024 1024 N/A
| add to System...
Usage Statistics
Available Pages:4032
Used Pages: 37 =]
Free Pages: 3995
4 1 - — r
B Used Space
B e T
) o

Figure 20 * System Builders - Memories Page
10. Save eNVM_DataClient_top and regenerate the eNVM_DataClient_top component by clicking

Generate Component in'SmartDesign.
11. Click Generate Bitstream to.complete the remaining steps to generate fdb file (synthesis,

place-and-route).
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12.Click Run PROGRAM Action to program the SmartFusion2 Security Evaluation Kit, see
Figure 21 and Figure 22 on page 20.

(@ Libero - C\eNVM DataClient\eNVM_DataClient.prix

Project File Edit View Design Tools Help
~ i
OS2 0

Design Flow

eNVM_DataClient_top

8%/ Repors & X | Startage § X | £ eNvM Dataclient top & X |

4 eNVM _DataClient_top reports - € 0Erors i, 0wamnos ) 0Info

4 eNVM_DataClient_top

Tool
& Verify Timing
[ Verify Power
& 10 Advisor
4 » Edit Design Hardware Configuration
Bl Programming Connectivity and Interface
& Programmer Settings
[ Devicel/O States During Programming
4 » Configure Security and Programming Options
2 Configure User Programming Data
Configure Programming Recovery
Configure Security
B Update eNVM Memory Content
Program Design
"4 BB Generate Bitstream
Run PROGRAM Action
bug Design
Identify Debug Design
€ SmartDebug Design
f 4 b Handoff Design for Production
i ¥ Export Bitstream
2 Export Programming Job
+£] Export Pin Report
€] Export BSDL
] Export IBIS Model
4 b Handoff Design for Firmware Development

S

“p Configure Firmware Cores

- NV _DataClient_top_ma FlashPro
€NVM_DataClient_top_pini Version: 11.6.0.34
eNVM_DataClient_top_pinr. Release: v1l.6
NIVM_DataClient_top_ban.. . )
eNVM_DataClient_top_ioff... Software Version: 11.6.0.34

Opened

# eNVM_DataClient *C: /ellVM_DataClient/designer/ellVM _DataClient_top/elfVM_DataClient_top_fp/eifid T

eNVM _DataClient CCC_0_c. The 'open_project' cormand succeeded

NVM_DatsClient MS5._ms. The 'load programming_data’ command succeeded.

The 'set_programming file' command
4 . Generate Memory Map Bricr mved

eNVM DataClient_top_Data... | || The 'save project' command succeeded
Synthesize Project closed.
synplifylog
i, eNVM_DataClient_top.srr
run_options.bt
Compile
@ <NVM_DataClient _top_.
NV _DataClient_top_com...
eNVM _DataClient_top_com...
Place and Route
NV _DataClient_top_glb_.
& eNVM_DataClient_top.
Generate Bitstream
eNVM_DataClient_toj
W 4 /. RunPROGRAM Action
E i, eNVM_DataClient_top_

8

.

I

S

S

gen..

| Desgnriow | DesignHerarchy | Catelog |

Log
[[E]Messages | @ Erors i Warnings @ Info

Software Version: 11.6.0.34

4 Export Bitstream

eNVM_DataClient_SYS_BLD... EDB file

eNVM_DataClient manifest.. 'C:\elV4_DataClient\designer\elNVM DataClient top\SaeObdcc-593-46£1-0§93-761188987611.pab' has
4 eNVM_DataClient_MSS been loaded successfully.

eNVM_DataClient_MSS_DR.. DESIGN : eNVM_DataClient top; CHECKSUM : SFE9; PDB_VERSION : 1.9

Opened 'C:/eNVM_DataClient/designer/eNVM_DataCli
The 'cpen_project' command succeeded.

PDB file 'C:\ellVM_DataClient\designer\elVM DataClient_top)\Sae0bdcc-£583-4

DESIGN : eNVM DataClient_top; CHECKSUM : SFES:
The "load_programming_data' command succeeded.
The "set_pregramming_file' command succeeded.
Froject saved.

The "save_project’ command succeeded

Project closed.

The 'close_project' command succeeded.

The Execute Script command succeeded.

Generating Bitstream File Finished : Wed Sep 30 11:

Log | Message

nt_top/eNVM_DataClient_top_fp/eNV¥_DataClient_top.pro’

-b593-T6£1£59376£1.pdb" has been loaded sucefssfully.

PDB_VERSION : 1.9

7:36 2015 (Elapsed time 00:01:02j

Figure 21 + Selecting Run PROGRAM Action
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) Libero - C:\eNVM _DataClient\eNVM _DataClient.prix

—— —

L.

Project File Edit View Design Tools Help

Design Flow

NVM_DataClient_top

S22 0R |

g x

Reports @ X

StartPage @ X | E2] eNviv_DataCient top & x|

B 00

Tool
@ Verify Timing
B Verify Power
& 10 Advisor

4 b Edit Design Hardware Configuration

I Programming Connectivity and Interface
& Programmer Settings
[ Device I/O States During Programming
4 b Configure Security and Programming Options
$8) Configure User Programming Data
B Configure Programming Recovery
@ Configure Security
B2 Update eNVM Memory Centent

eNVM_DataClient.log
4 eNVM _DataClient_top reports
4 eNVM DataClient _top
eNVM_DataClient_top_man.
eNVM_DataClient_tap_pint...
NVM_DataClient_top_pine:
NVM_DataClient_top_ban.
eNVM_DataClient_top_io
eNVM_DataClient
NVM_DataClient CCC_0c..
€NVM_DataClient 5VS_BLD.
eNVM_DataClient_manifest...
eNVM_DataClient_MSS
NVM_DataClient_MSS_DR.
NVM_DataClient MSS_ma..
4 A Generate Memory Map

N

N

4 ) Program Design
B Generate Bitstream
B Run PROGRAM Action

4 ) Debug Design

£, Identify Debug Design

€ SmartDebug Design

Handoff Design for Production

i ) Export Bitstream

48 Export Programming Job
Export Pin Report

+£] Export BSDL
+£] Export IEIS Model

4 ) Handoff Design for Firmware Development
& Configure Firmware Cores
B Export Firmware

CAS S

Design Flow | Design Herarchy | Catalog |

og

[E]vessages ) @ Eros iy Warnings @ Info

programmer '94331' : Scan Chain.

Tound & instruction register bits
: Checking IDCODEs
: Device 1: 1FB07ICF

programmer '94331'
programmer '94331'
programmer '94331'

programmer '94331' : Check Chain...
programmer '94331' : Scan and Check Chain PASSED.
o Version: 11.6.0.34

Version: 11.6.0.34
Version: 11.6.0.34
Version: 11.6.0.34
Version: 11.6.0.34

Executing programming action FROGRAM
Software Version: 11.6.0.34

Log | Message

S

.

N

N

eNVM_DataClient_top_Data
Synthesize
synplify.log
i eNVM_DataClient_top.si
run_options ixt
Compile
@ eNVM_DataClient_top._...
eNVM DataClient top_com.
eNVM DataClient_top_com...
Place and Route
€eNVM_DataClient_top_glb._..
@ eNVM_DataClient top_..
Generate Bitstream
€eNVM_DataClient_top_gen.
i Run PROGRAM Action
i\ eNVM_DataClient_top_..
i Funoct Ritcn

@ oemors i, owamings i 0 Info

FlashPro
Version: 11.6.0.34
Release: v1l.6

Software Version: 11.6.0.34
Opened
"C:/eNVM_DataClient/designer/eNvM |

taClient_top/eNvH |

taClient_top fp/eNVM I

taClient_top.pro’

The "open_project’ command succeeded.
PDB file
"C:\elVM_DataClient\designer\eNVh |
been loaded successfully.

DESIGN : eNVM_DataClient_top; CHECKSUM :
The "load programming data' command

The "set_programming file' command succeeded
Project saved.

The "save_project’ command succeeded.

9FES;

PDB_VERSION :

Project closed.

Libero

Running PROGRANM Action, Please do not interrupt.

1

taClient_toph\4fflefaa-508f-45e3-308%:

9

-15e2508£15e2.pdb" has

Actel Part: M25/M2GL090(TITSITV)

Figure 22 » Programming SmartFusion2 Security Evaluation Kit

Updating eNVM Memory Content

This option is available in Libero design flow to load the updated .hex files after compiling the application
code in SoftConsole:s Without this option, every time the SoftConsole application is built, System Builder
eNVM Configurator is required for updating the eNVM client with the new .hex file generated, which is

time consuming.

If the new .hex file generated from the SoftConsole application project is larger than the previous .hex
file, Update eNVM Memory Content throws an error. Go back to the System Builder and manually

update the Hex file.

20
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The following steps describe how to use Update eNVM Memory Content option:
1. Choose Update eNVM Memory Content option from Libero design flow.

:Eg

-
() Libero - C:A\eNVM DataClient\eNVM DataClient.prjx*

Project File Edit View Design Tools SmartDesign Help

W™ 0

Design Flow 8% | Repots mx | EeiMDatcinttop 8 X | Startrage & x| i
&NVM_DataClient_top (S >] g’ 25K "E F”" oF P EP @, (D\ @ A \ O
Tool i E
IZI Verify Power
& 10 Advisor
4 b Edit Design Hardware Configuration
I Programming Connectivity and Interface
’ Programmer Settings
{2 Device /0 States During Programming eNVM_DataClient_0 E
4 b Configure Security and Programming Options 4B RESET N FOWER_ON RESET N
) Configure User Programming Dats DErET bR DR pEADY
B2 Configure Programming Recovery 7] MUUART_1_FADS[4
@ Configure Security T
@ Update eNVM Memory Content = Fﬁ%&xﬁ%g
¢ 4 » Program Design T NIT_ANSE h
@ Configure Bitstream N-er;
v B2 Generate Bitstream I
v B2 Run PROGRAM Action
4 b Debug Design
¥4 Identify Debug Design - il
DesignFiow | DesignHierarchy | Stmulus Herarchy | Catslog | Fies | | L* o - b
Log : | ) F X
&3 Errors i, Warnings i} Info
R — R y >

programmer '90947' : device 'M25090T" :
| programmer '90947' : device 'M250901" : [

programmer "90947' : dewvice 'M25090I"' : Programming FPGA Array and eNVM...
programmer '90947' : device 'M25080T" :
programmer '90947' : device 'M25090T" : EXPORT DSN([128] = 590ff38e5f7d56fbTaabd75149cad220
programmer '90947' : dewice 'M250901" :
programmer '90947' : device 'M25090I"' : Finished: Mon Feb 09 12:37:24 2015 (Elapsed time 00:01:42) |_|
programmer '90947' : device 'M25090T" : Executing action PROGRAM PASSED.

nromrammer 1619471 + Chain mroaramming PLSSET

Fam: SmartFusion2 | Die: M2S090T |Pkg: 484 FBGA | Verilog

Figure 23 « Choosing Update eNVM Memory Content Option from Libero Design Flow
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2. Update the eNVM Memory Content window as shown in Figure 24.

r .
1] eNVM Update Tool (2 e

P -

Rk User Clients in eNVM

Data Storage
Serialization Client Type Client Name DepthWidth Start Address{Hex) Page Start Page End Initislization O
1 @ DataStorage Main_App 4592 % & o 0 35 /A
2 ||@ DataStorage lock 4x8 20000 1024 1024 NfA
Add to System. ..

Usage Statistics

Available Pages: 4032
il Used Pages: 37

Free Pages: 3995
i
i
! < L] - -4 b
i
: ‘You can disable programming for a dient by editing the dient and selecting the Mo Content’ option.

The content will be preserved and programming of this dient can be re-enabled by selecting the preserved content,
|
| B Used Space
B e
|
|

=

— — e ]

Figure 24 » eNVM Memory Content Window

3. Browse through the updated .hex file generated in the Release Mode from the SoftConsole
application project, see Figure 25. Click- Ok.

E=E
@‘ ] C:\eNVM_DaIaCIienl\SuﬂCunsule\eNVM_DalaClie ctsheMViv_DataClient_MSS_CM3_app\Release]
———,
Organize « Include in library = Share with = Burh Mewi folder ==~ @
¢ Favorites *  Name : Date modified Type Size
B Desktop || eNVM_DataClight_MS5_CM3_app 30-09-201511:38 File 128 KB
& Downloads |_| eNVM_DataClient_MS5_CM3_app.hex 30-09-201511:38 HEX File 13 KB
5] Recent Places |_| eNVM_DataClient_MS5_CM3_app.lst 30-09-201511:38 LST File 106 KB |
|_| eN¥M _DataClientaMS5_CM3_app.map 30-09-201511:38 MAP File 54 KB
7 Libraries E || eNVM_BataClient MS5,CM3_app.srec 30-09-201511:38 SREC File 13 KB
= Documents || main.d 30-09-201511:38 D File 1KB
o Music || main.o 30-09-201511:38 O File 3KB
[E] Pictures ' || makefile 30-09-201511:38 File 3KB
=] Subversion memary-map 30-09-201511:38 XML Document 1KB
B Videos — | ]'objeets.mic 30-09-201511:38 MK File 1KB
| | sources.mlk 30-09-201511:38 MK File 2KB
18 Computer || subdir.mk 30-09-201511:38 MK File 3KB
&l Local Disk (C:)
’ 12 items

Figure 25 » Updated Hex File in Release Folder

4. Click Generate Bitstream to complete the remaining steps to generate fdb file (synthesis,
place-and-route).

5. Click Run PROGRAM Action to program the SmartFusion2 Security Evaluation Kit.
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Running the Design on SmartFusion2 Security Evaluation Kit

The following steps describe how to run the design:
1. Connect the FlashPro4 programmer to the J5 connector of SmartFusion2 Security Evaluation Kit.

2. Connect the host PC to the J18 connector provided on the SmartFusion2 Security Evaluation Kit
using the USB min-B cable. Ensure that the USB to UART bridge drivers are automatically
detected (can be verified in the Device Manager as shown in Figure 26).

Note: Copy the COM port number for serial port configuration. Ensure that the COM port location is
specified as on USB Serial Converter D, as shown in Figure 26.

= Device Manager l = | [E] ﬂh]

. . . B
File Action View Help USB Serial Port (COMS) Properties ==
s @ EIHEIEF&RS

4= wibd-edarap
> 1M Computer USE Serial Port (COME)
C e
- Disk drives =
- B Display adapters
b - DVD/CD-ROM drives
+ W5 Human Interface Devices

General | Port Settings I Driver I Detail5|

Device type: Ports [COM.& LPT)
Manufacturer: FTDI

b g IDE ATASATAPI controllers Location: on USE Senal Converter D

- ¥ Jungo

b Keyboards Device status

:» ﬂ Mice and other pointing devices This device is working propery. -
> Bl Monitors

b ¥ Metwork adapters

473" Ports (COM & LPT)

" ? Communications Port (COM1)
‘? USE Serial Port (COM3)

‘? USE Serial Port (COM4)

‘? USE Serial Port (COMS)

i

"= USB Serial Port (7™ b

Update Driver Software...
>-D Processors
b -5 Sound, video and gi Disable
b M System devices Uninstall
b - § Universal Serial Bus OK ] [ Cancel

Scan for hardware changes|_

Opens property sheet fort Properties

Figure 26 - Device Manager Window

3. If USB to UART bridge drivers are not installed, download and install the drivers from
www.microsemi.com/soc/documents/CDM_2.08.24_WHQL_Certified.zip.

4. Connect the power supply to the J6 connector and switch ON the power supply switch,SW7.

5. Start the HyperTerminal program with a baud rate of 57600, 8 data bits, 1 stop bit, no parity, and
no flow control. If the PC does not have HyperTerminal program, use any free serial terminal
emulation program such as PuTTY or TeraTerm. Refer to the Configuring Serial Terminal
Emulation Programs Tutorial for configuring the HyperTerminal, TeraTerm, and PuTTY.

6. Program the SmartFusion2 Security Evaluation Kit Board with the provided programming file
using the FlashPro software (Give the *.stp file path. Refer to "Appendix A: Design and
Programming Files" on page 45).

Note: This step is required if *.stp file in the design folders is used. In Libero design, Run PROGRAM
Action programs the *.stp file to the Board.

7. After successful programming, press SW6 switch to reset the board.

8. The serial terminal program displays the user options as shown in Figure 27.
Select option 1 to get Factorial of number 2.
Select option 2 to get Factorial of number 3.
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Select option 3 to get Factorial of number 4.

#  Serial_Output - HyperTerminal - [E=E
Eile Edit View Call Jransfer Help a

D& E DH &

HiH Welcome to SmartFusion? HHHH
Please Select the Following option
1.Factorial of 2
2.Factorial of 3
3.Factorial of &

Figure 27 » Selecting Factorial of a Number - User Options

The application image fetches the Factorial Value from the Look up table (Non-executable image)
and displays it as shown in Figure 28.

r Bl
¥ ° Serial_Output - HyperTerminal - E@g

File Edit View (Call Transfer Help

#iH# Welcome to SmartFusion2 Hid#
Please Select the Following option
1.Factorial of 2

2.Factorial of 3

J.Factorial of 4

Eactorial of 2:

Please Select the Following option
1.Factorial of 2

2.Factorial of 3

3 .Factorial of 4

Eactorial of 3:

Please Select the Following option
1.Factorial of 2

2.Factorial of 3

J.Factorial of 4

Ezctorial of &:

Please Select the Following option
1.Factorial of 2
2.Factorial of 3
3.Factorial of 4

Connected 0:00:11 Autodetect 57600 8-N-1 NUM

Figure 28 « Displaying Factorial Value Based on User Option
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Building Multiple Executable Images in Release Mode

The design files are available for download from the following path in the Microsemi website:
http://soc.microsemi.com/download/rsc/?f=m2s_ac426_liberov11p6_df

This design contains the eNVM data storage clients for Multiple Hex images. It runs the images in eNVM
and eSRAM, and the LEDs blink in various patterns. This design demonstrates how to build multiple
images in the release mode and store them in eNVM.

The following steps describe how to build multiple application executable image in the release mode:
1. Open the standalone SoftConsole IDE.

nsole DEVIAT bt s e e

SC C/C++ - Welor
File Edit Sourc

T ———
4 G- 8-E-G- K-8 I$-0 Q- ®P- - E- T 86T
= BY(E2 Outi 5 @ Mak | = O

An gutling s not available.

(25 Project Explorer 52 = O[5 Welcome £3
= % 7| Microsemi SoftConsole IDE v3.4

File > New > C Project
and select a toolchain if you are going to
get other than the default choice of the Microsemi Cortex-M3,

ource File

[2 Problems 52 ¥ Tasks| & Console| = Properties

Oitems
Description B Resource Path Location  Type

Figure 29 « SoftConsole IDE
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2. Right-click the Project Explorer window and choose Import as shown in Figure 30.

SE C/C=+ - Welcome to Microsemi SoftConsole IDE v34 - JETOE V34

File Edt Source Refactor Navigate Search Project Run Window Help
w52 9
() Project Explorer &% = B[ Welcome 52
= % 7| Microsemi SoftConsole IDE v3.4
SoftConsole is afree software development environment
enabling the rapid production of C and C+ executables fo processors
available for use in Microsemi devices. Creating a project nside SoftConsale

fesyou sl compled nto 3 sable biary:

[

g impor

(e 5 StartaPrject

4 Export. To begin your work, click File > New > C Project

R Give yourprject a hame,and slecta toolchain f you are ging to

&) Refresh 5 be compiling for a target other than the default choice of the Microsemi Cortex-M3.

“Then click Finish.
‘Add an initialsource file with File > New > Source File

Add codeto it and click the Build Allicon.

5 Existing Code:
You can also import an existing source tree using

General > File System

5 Additional Information
* Release Notes

* Online documentation

[2 Problems 2 ] Tasks| Bl Console| = Properties|

B R-B-i%-0-A- 8 -

| -]

)
= B8 outii 2\ @ Mak | = B

‘An outline i not available.

[ A e
Figure 30 * SoftConsole IDE - Import
3. Select General > Existing Projects into Workspace as shown in Figure 31.
SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsemi SoftConsale IDE 34 — - = =
i~ , é'ﬁ?'f'(z‘?" o5e B0 A @ P -5 S

e = 5[ Welcome %

= % 7| Microsemi SoftConsole IDE v3.4

SoftConsole is  free software development environment
enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConsole:
lets you write software that is immediately compiled into  usable binary.

S€ Import

Select
S Starta Project

To begin your work, click File > New > C Project

Give your project a name, and select a tbolchain if you are going to

be compiling for a target other than the default choice of the Microsemi
“Then click Finish.

‘Add an initial source file with File > New > Source File

Create new projects from an archive file or directory.

Select an import source:

[ iter e

Add codeto it and click the Build Allicon

4 (= General
G, Archive File
£ Existing Projects into Workspace
(5, File System

| o

5 Additional Information
* Release Notes

*Online documentation

[2 Problems 2 ] Tasks| B Console| = Properties|
0items

Description Resource Path

14 0 items selected

Location  Type

B (@)
= B8 outii X\ @ Mak | © B

‘An outline i not available.

Figure 31 » SoftConsole IDE - General
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Import window is shown in Figure 32.

SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsem SoftConsole IDE v3.4

—— — — = =
Fie £t Souce Refactor Navigste Search Project Run Window Help
=he 9isi@E -8 B-6- K- B i%$-0-Q- L I@NIH-F e 5(Ee)
[ Project Explorer 23 = 8)(B Welcome % =55 outi % Mak | = 0
= % 7| Microsemi SoftConsole IDE v3.4 A catine = not avarlabic
SoftConsole s a free software development environment
ensbling the rapid producton of C and Ce- executablesfor processors
svailable for use in icrosemi devices. Creating s project nside SoftConsole
letsyou write software that i immeditely compiled into a usable bina
% VEDES 2y SC Import =|6
< Import Projects
3 Starta Proj
ot Select  directory to search or esting Eclipse projects
Give your project a name, and select a toolchain if you are going to -
be compiling for s target other than the defaut choice of the Microseri
Then click Finish. ) Select root directory: Browse.
‘Add an initial source file vith File > New > Source File eect archivefle Browse.

Add codeto it, and click the Build Allicon Boms

Select All
® bisting Code
You can lso import an exiting source ree using Deseect Al
Fle > Import..

and

tk

) Additional Information
* Release Notes

* Online documentation (] Copy projects into workspace

Working sets
7)Add project to working sets

Warking sets Select.

® b [

2 Problems 52 Tasks | ] Console| I Propertes| e
Description - Resource Path Location  Type
g 0 items selected
Figure 32 « SoftConsole IDE - Browse
selcces = =]
=he 96 i@ S-F-EG-iIR-B H-0 - I ®P-IE B -5 - o B % Debug (TG~
(2 Project Explorer 52 BEg~=0 = B)(8= outi 3 Mak} =0
56 Import le[al =]
Import Projects
-
© Selectrootdirectors
(] N1 L
\ Browse For older ==
-
(2! Problems|(2 Tasks ] Cogbole 3 . Propertes| ¥ Con > BB fimmare < E-r3-=0
[C] Add project to working g ). simulation
Working sets b 11 smartgen
@ <Bad| ! imag;
= -
< ;
=

Figure 33 » SoftConsole IDE - Browsing for App Folder
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4. Ensure that Copy projects into workspace check box is checked as shown in Figure 34. Click
Finish.

SC Import

Import Projects

Select a directory to search for existing Eclipse projects.

|}

(@) Select root directory:  C\eNVM_Multiple_Images'LiberoProject\Rem: Browse...
() Select archive file: Browse...
Projects:

eMVM_to_SRAM_imagel (C:heMNVM_Multiple_ImagesiLiberoProjec Select All
eMVM_to_SRAM_image2 (C:heMNVM_Multiple_ImagesiLiberoProjec
eNVM_to_SRAM_image3 (CheMNVM_Multiple_Images'LiberoProje
eMVM_to_SRAM_imaged (CheMNVM_Multiple_ImagesiLiberoProjec
Remapping_Appnote_MS5_CM3_app (C:heNVM_Multiple_Images'
Remapping_Appnote_MS5_CM3_hw_platform (C:heMVM_Multiple
sample_image_eMVM_128KB (C:heNVM_Multiple_Images\LiberoP)

4 | i | b

Copy projects into workspace
Working sets
[] Add project to working sets

- _/l |_E|E-:t...

@ [ <Back J© Neas [ Fmsh [ Cancel

Figure 34 + SoftConsole IDE - Creating Work Space in App Folder
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The SoftConsole perspective is shown in Figure 35.

SC C/C++ - Microsemi SoftConsole IDE v34 e

oo -

File Edit Source Refactor Navigate Search Project Run Window Help

i |6 92 8 @8- K-8 $-0-Q%~ &~ AR RS RER A g w [Eoc=) &
(7 Project Explorer 3 BE%~Y=0 = B](8z outh 2\ @ Mak | = B
b 5 eNVM_to_SRAM imagel -
> £ eNVM to_SRAM image2 An outline is not available.
» 2 eNVM _to_SRAM_image3
b 5 eNVM_to_SRAM imaged
» 5 Remapping_Appnote MSS_CM3_app
» 22 Remapping Appnote_MSS_CM3_hw_platform
» (22 sample_image_eNVM_128K8)
[2 Problems | ¥ Tasks | ] Console 23 I Properties| 8
C-Build [sample_image_eNVM_128KE]
o 2 sample_image_eNVM_128KB
Figure 35 * SoftConsole Workspace
SC C/C- - Remapping. Approte.MSS.CM3_app TEvia —I— < e ~— econ e
5~ B9 B O-F -G i R-B B0 Q@O & iy s [ %5 Debug [FFC/Cr)
[ Project Explorer 23 B %~ = O)@ minc X = 0)(55 Outh 2 \_© Mak | = O
> 25 eNVM_to_ SRAM.imagel I#include "m2sxxx.nn R AR 0 kT
» [ eNVM_to_SRAM_image2| 2#include "drivers/mss_uart/mss_uazf.nt T
b 25 eNVM_to 4 F " 57
> B I A e, b £+ remap user code_eSRAI
i R Tvota renallloc. cocn csun R :  remap e code oM
= Copy ctrsC 5void rémap user code eSRAM 1(void); & ESRAMD REMAR
Tt ey 9void remap user_code_eNVM_128KB(void) ; # ESRAMI REMAP
1 # ESRAM2_REMAP
X Delete Ceed o # ESRAM3_REMAP
B Import. 1. # ENVM_DEMO_IMAGE S|
Build Project 1 ©  copy.image_to_ram(int)
8 reigl \ 21#define ENVM DEMO_IMAGE STORED 2 0x60012000 o remap.encole.
Close Project 22#define ENVM DEMO_IMAGE STORED_3 0x60016000 pavsess -
Close Unrelated Projects 2 -7 N - o1 remeplieicodelsRAY
24v6iarEopy image_to_ram(int type) o e R
Make Targets T »[[V] 2Relesse jFrsEesaass
Detug s y [EL Problems 2 ¥ Tasks| & Console | I Properties = =
Team 4 Description - Resource Path Location  Type

S 7 items selected

Figure 36 * Building Configuration
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6. Go to Project > Build All and build the project as shown in Figure 37.
.hex file is generated in the Release folder created in the project folder.

50 C/ch+ - NV Daie TR VB S VR SRS e I ——— — e

File Edit Source Refactor Navigate Search [Project] Run Window Help

A @6 Open Project v @ = Flefles vy ([ oc~
| CloseProject == ——
{15 Project Bplorer 23 O[3 outii 2\ @ mak | = 0
» iz eNVM_DataClient MSS_CN3_app| ap Build All Cirl+B / - BRY o %7
> [£5 eNVM_DataClient_MSS5_Ct __platform Build Configurations » RO U m2sexh
Build Project 21 drivers/mss_uart/mss
Build Working Set > # ENVMLDEMOIMAGE S
e o printnumber(nt):nt
o UART Polled o(mss_ua
Build Automatically € components 0 Sl
i T art1,MSS_UART_57600_BAUD,MSS_UART_DATA 8 BITS | MSS_UART_NO_PARITY | MSS_UART_ONE STOP_BIT ): o main s
Make Target » [UART polled cx (sg_mss_warci, (sinte_c «)"$### Welcome to SmarcFusion $3##\n\z",sizeof("#### Welcome To SmarcFusion2 $###\m\z’));:
Properties e
T
155_URRT_polled tx (sg_mss_uarcl, Select the Following optiom\m\z'));: f
}55_UART_polled tx (sg_mes_uarcl, Factorial of 2\m\z", Factorial of 2\n\
155_URRT polled tx (sg_mss_uarcl, X Factorial of 3\n\r" sizeof ("2.Factorial of 3\n\ =
155_URRT polled tx (6g_mss_uartl, (uinté_t %)"3.Factorial of 4\m\z",sizeof ("3.Factorial of £\m\z")):
while( (!(UART_Polled Rx ( &g_mss_uartl, rx buff, 1))) )
data = *(ansigned int *)ENVM DEMO_TMAGE_STORED_ADDR;
byte(s] = data & OXFF; /* u
o ety = pianen es o « o ac . E < (- E
(2! Problems |2 Tasks |l Console 53 (] Propertes| @G BE-r5-=0

C-Build [eNVM_DataClient_MSS_CM3_app]

%% Clean-only build of configuration Release for project eNVM DacaClienc MSS_CM3 app *++*

make clean
Tm -rf ./eNVM DataClient MSS_CM3_app.map

m -rf memory-map.xml ./main.o ./main.d eNVM DataClient MSS_CM3_app.srec eNVM DataClient MSS_CM3_app.hex eNVM DataClient MSS CM3 &pp.1st eNVM_DataClient MSS_CM3_arp
eNVM_DataClient MSS_CM3_app

1} 1 2 items selected

Figure 37 « Build All
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Loading Multiple Executable Images into eNVM

Multiple SoftConsole application projects generate multiple executable images. These executable
images are stored in eNVM.

The following steps describe how to load the generated application executable images into eNVM of the
SmartFusion2 device using the System Builder eNVM Configurator:

1. Open the Libero SoC hardware project Remapping_Appnote_top tab.

e , — . i )
(® Libero - C:\eNVM_Multiple_Images\LiberoProject\Remapping_Appnote\Remapping_Appnote.prix® G=REC

Project File Edit View Design Tools SmartDesign Help

NEeW ™03

i

4l

8 %[ Reports_§ X_| Startpage & x | 0 Remappng_aponot=_top* 3 X |
Renagan st op EC0RE BeErp M2 QARAE AND

Tool
W 4 » Create Design
& System Builder
("4 & Configure MSS
Create SmartDesign
Create HDL

Remapping_Appnote_0

B8 Create SmartDesign Testbench i |
Create HDL Testbench J 4 D FAB_RESET N  POWER_ON_RESET_NIPX
4 b Verify Pre-Synthesized Design [DEVRST NB—— @ DEVRST_N DDR_READY P X
B simulate MSS_READY B X

| MDDR_PADSEI@--------- MDDR PADS

4 b Create Constraints

4 = /O Constraints INT_PNSE
@ constraint\io\Remapping_Appnate_top.io.pdc INIT_DONE X
4 & Timing Constraints FAB_CCC_FNSEH
@ synthesis\Remapping_Appnote_top_sdc.sdc GO FABRICEH@--------- GHO _FABRIC

HMMVUART 1_PADS

By Floorplan Constraints

A, 4 » Implement Design
A T Synthesize |
4 b Verify Post Synthesis Implementation
B simulate f
' 85 Compile i

{1 Confiqure Flash*Freeze

Design Flow | Design Hierarchy | Stmulus Hierarchy | Catalog | Files |

og

=[Messages | €3 Erors /iy Warnings @ Info ‘
®¥inro: 'Remapping Appnote MSS' was successfully generated.
Info: 'Remapping Appnote MSS' manifest file 'C:/eNVM Multiple Images/Li Jects j ppaote, work/] q_Appnote MSS/
generated.

g_Appnote_MSS_manifest.txt' was successfully

®nco: Remapping Appnote’ was successfully generated.
®nco: Remapping Appnote’ manifest file "C:/eNVM Multiple Images/Li Ject, | Appnote g_Appnote.

g_Appnote_manifest.txkt' was successfully generated.

o

®nco: Systenm Builder successfully gemerated 'Remapping Appnote’. Open System Builder summary for details -

log | Message

Fam: SmartFusion2 [Die: M25090T | [Pkg: 484FBGA  [Veriog

Figure 38 - Remapping_Appnote_top Tab

2. Double-click Remapping_Appnote _0 and go to System Builder - Memories page to add the
eNVM.Data Storage client as shown in Figure 38 and Figure 39 on page 32.
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3. Select Data Storage under the Available Client types and click Add to System..., see
Figure 39. This opens Add to Data Storage Client window as shown in Figure 40 on page 33-

- = - TS — o
( System Builder - Memories | G |
Device Features Memories » > Peripherals » 7 Clocks Microcontroller SECDED Security > 2 Interrupts > > Memory Map >
Configure your external and embedded memories
MDDR \/ ENVM \
Available Client types User Clients in eNVM
Data Storage
Serialization Client Type I Client Name DepthxWidth I Start Address(Hex) Page Start I Page End Tnitialization Order I Lock Start £
Add to System...
Usage Statistics
Available Pages: 2032
UsedPages: 0
Free Pages: 2032
< n ] v

Figure 39 * System Builder - Memories Page
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5| Add Data Storage Client l ? &1
Client name:
eMvM
Content:
@ Memory file: :]
Format:
[ Use absolute addressing e
() Content filled with 0s
) No Content {Client is a placeholder)
Start address: 0x 0 =
Size of word: bits
Mumber of Words: 1 (decimal)
|:| Use as ROM o
[ use Content for Simulation
[
[ Ok ] [ Cancel
| W, S ——

Figure 40 + Add to Data Storage Client Window
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4. Enter a data storage client name in the Add to Data Storage Client window.

5| Add Data Storage Client

? [ |

Client name: eMVM_MainApp_HexFile0
ehVM
Content:

@ Memory file:

Format:

[] use absolute addressing e
() Content filed with 0s

) No Content {Client is a placeholder)

Start address: 0x 0 =
Size of word: bits
Mumber of Words: 1 (decimal)

|:| Use as ROM o

[ use Content for Simulation

==

Figure 41 + Add to Data Storage Client Window
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5. Browse for the .hex file generated after compiling the SoftConsole project in the Release Modes,
see Figure 43 on page 36. The generated executable image is in the Release folder under
SoftConsole project workspace, see Figure 42.

|/ t\Remapping_Appnote\SoftConsole\Remapping_Appnote_MSS_CM3\projects\Remapping_Appnote_MS5_CM3_app\Release ~ | ¢
i Al =

Organize Include in library Share with + Burn New folder >~ [ @
3 Favorites Name ’ Date modified Type Size

Bl Desktop || main.d 30-09-201512:23 D File 2KB
4 Downloads || main.o 30-09-201512:23 O File 4 KB
] Recent Places | makefile 30-09-201512:23 File 3KB
=] memory-map 30-09-201512:23 AML Document 1KB
7l Libraries || objects.mk 30-09-201512:23 MK File 1KB
@ Documents |_| Remapping_Appnote_MSS_CM3_app 30-09-201512:23 File 128 KB
J’ Music |_| Remapping_Appnote_MSS_CM3_app.hex  30-09-201512:23 HEX File 15KB
[E5] Pictures || Remapping_Appnote_MSS_CM3_app.lst 30-09-201512:23 LST File 139 KB
=1l Subversion |_| Remapping_Appnote_MSS_CM3_app.map  30-09-201512:23 MAP File 61 KB
E# videos |_| Remapping_Appnote_MSS_CM3_app.srec  30-09-201512:23 SREC File 15KB
|| sources.mk 30-09-201512:23 MK File 2KB
1% Computer || subdir.mk 30-09-201512:23 MK File 3KB

&, Local Disk (C)

—a Mew Volume (D:)

e'j MNetwork

12 items

Figure 42 « Executable Image in Release Folder

Revision 4 35



& Microsemi

Implementing Production Release Mode Programming for SmartFusion2 - Libero SoC v11.6

" -
(** Add Data Storage Client

E I |

Client name:

eNVM_MainApp_HexFile0

eMVM
Content:

@ Memory file: pp/Release/Remapping_Appnote_MS5_CM3_app.hex

Format: |Intel-Hex -

[] use absoluts addressing 1)

! Content filled with Os

! Mo Content (Client is a placeholder)

Start address: ox 0 =
Size of word: 8 | bits
Mumber of Words: 5040 (decimal)

|:| Use as ROM 6

[] Use content for Simulation

] I Cancel

b

Figure 43 « Add Data Storage Client Window

6. Click Ok in the Add Data Storage Client window.

7. Add the remaining Hex Files with their corresponding start addresses as shown in Figure 45 on
page 37.

Table 2 lists the SoftConsole application projects in the Release mode, their .hex files, and their mapping
to the eNVM Client Name.

Table 2 - -SoftConsole Application Projects and their Mapping to eNVM Client

ENVM Client Name

SoftConsole Release Mode Path

Hex File Name

Start
Address

eNVM_MainApp_HexFile0

Remapping_Appnote_MSS_CM3_app\
Release

Remapping_Appnote_MSS_CM3_
app.hex

0x0

eNVM_to SRAM_HexFile1

eNVM_to_SRAM_image1\Release

eNVM_to_SRAM_image1.hex

0x4000

eNVM_to SRAM_HexFile2

eNVM_to_SRAM_image2\Release

eNVM_to_SRAM_image2.hex

0x8000

eNVM_to_SRAM_HexFile3

eNVM_to_SRAM_image3\Release

eNVM_to_SRAM_image3.hex

0x12000

eNVM_to_SRAM_HexFile4

eNVM_to_SRAM_image4\Release

eNVM_to_SRAM_image4.hex

0x16000

eNVM_128KB_HexFile5

sample_image_eNVM_128KB\Release

sample_image_eNVM_128KB.hex

0x20000
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Note: Start address is the address in which the executable image is stored in eNVM. Provide the required
memory size based on the total size of the executable image. Otherwise, the images overlap and
displays error as shown Figure 44.

— - ~— — — GE'E;‘

- — —
(3" System Builder - Memoaries

> Device Features Memories » » Peripherals » > Clocks Microcontroller SECDED Security > > Interrupts » » Memory Map »
Configure your external and embedded memories
MDOR /% ENVM
HEIlsEElgrs User Clients in eNVM @
Data Storage
Serialization Client Type Client Name DepthxWidth Start Address{Hex) Page Start Page End Initialization Order
fl 1 | Datastorage eNVM_MainApp_HexFile0 5040 x 8 0 0 39 N/
2 || DataStorage|  eNVM_to_eSRAM HexFiel 4576 %8 2000 54 39 NA
Add to System...
3 ||@ Datastorage|  eNVM_to_eSRAM_HexFie2 4576 %8 3000 6 131 NjA
Usage Statistics * |§) DataStorage|  eNVM_to_eSRAM_HexFile3 4576 %8 5000 160 195 DA
Available Pages:4032 5 .
g €D DataStorage|  eNVM_to_eSRAM HexFiled 4576 % 8 7000 24 259 MA

FreePages: 3810 S eNVM_128KB_HexFileS 4784x 8

M Used Space
=

Figure 44 « Error due to Image Overlap

Figure 45 shows the correct memaory. locations chosen. It does not display any error.

(T i i, v e D e
> Device Features » » Memories » » Peripherals » » Clocks  » » Microcontroller »  SECDED _» » Security » » Interrupts » » Memory Map »

Configure your external and embedded memories

MDDR )/ ENVM "\
Available Client types User Clients in eNVM
Data Storage
Serialization Client Type Client Name DepthuWidth Start Address(Hex) Page Start Page End Initialization Order
f 1 || DatzStorage eNVM_MainApp_HexFiled 5040 x 8 0 0 39 N/A
2 | @) DataStorage|  eNVM_to_eSRAM_HexFilel 4576 x 8 4000 128 163 N/A
Add to Systcpeg 5 | @) DetaStorage|  eNVM_to_eSRAM_HexFile2 4576 x8 8000 256 291 N/A
Usage Statistics * | €9 DataStorage| eNVM_to_eSRAM_HexFile3 4576 x 8 12000 576 611 N/A
= 052 5 | @ DataStorage|  eNVM_to_eSRAM_HexFiled 4576 x8 16000 704 739 N/A
UsedPages: 222
FreePages: 3810 © | €9 DatasStorage eNVM_128KB_HexFile5 4784x8 20000 1024 1061 NjA
4 nr L3
B Used Space
B FreeSpace Optimze Edit Delete

| e ) e ] oo J[ wec ]

Figure 45 * Hex Files with Correct Start Addresses
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8. In the System Builder - Memories page, keep the other settings to default and click Next, see
Figure 45 on page 37.

9. Save Remapping_Appnote_top and regenerate the Remapping_Appnote_0 component by
clicking Generate Component in SmartDesign.

10. Click Generate Bitstream to complete the remaining steps to generate fdb file (synthesis,
place-and-route).

11. Click Run PROGRAM Action to program the SmartFusion2 device to initialize the eNVM with the
memory file as shown in Figure 46 and Figure 47 on page 39.

= —~— 3 ~—
[ Libero - CANVM_Multiple_ImagesiLiberoP  Approts - —— — < T—

Project File Edit View Design Tools SmartDesign Help

~ g
DM a0l &
Design Flow 8 || @ remapping Appnote_top® B X | Reports @ X | Starteage & x|
Remapping_Appnote_top g o @' BE b O—B radnad Aol ey @ AN DO
Tool 2
+£] Configure Flash*Freeze
v #5 Place and Route )
4 Edit Constraints i .
+E /O Constraints ; Remapping_Appnote_0
@ Timing Constraints |
B Floorplan Constraints 4D FAB_RESET N  POWER ON_RESET_N §

4 b Verify Post Layout Implementation DEVRST N DEVRST_N DDR_REA DY

+£] Generate Back Annotated Files MSS_READY X
B Simuiate - i MDDR_PADSE@ —------- MDDR_PADS
& Verify Timing | INT_PINSE
v P ‘ ; INIT_DONE X
4 b Edit Design Hardware Configuration FAB_CCC_PINSE
¥ Programming Connectivity and Interface |= i GPIO_FA BRICEH@ ~------- GPIO_FABRIC
& Programmer Settings MMUART_1_PA DS E! BY - FHMVUART_1_PADS
i Device /O States During Programming | ! G- 4

4 » Configure Security and Programming Options
42 Configure User Programming Data
BB Configure Programming Recovery
@ Configure Security
BB Update eNVIM Memory Content
i 4 » Program Design
v BB Generate Bitstream
i BB Run PROGRAM Action
4 ) Debug Design

Design Flow | Design Hierarchy | Catzlog | )

Log

([l Vessages ) @ Erors 4y Warrings i 1nfo

Version: 11.6.0.34
Release: v11.6

Software Version: 11.6.0.34
Opened 'C:/eNVM Multiple Tmages/LibercProject/Remspping Appnote/designer/Remspping.Appnote top/Remapping Appnote_to
The 'open_project’ command succeeded.

PDB file 'C:\eNVM Multiple_Images\LiberoProject\Remapping_Appnote\designer\Remapping_Apphote_top\52576ee5-e379-4£62-a379-7£62e3797£62.pdb’ has been loaded successfully.

fp/Remapping_Appnote_top.pro’

DESIGN : Remapping_Appmote_top; CHECKSUM : SBF2; PDB_VERSION : 1.9
The 'load programming data’ cormand succeeded

The 'set_programming file' command succeeded.

Project saved.

The 'save_project' command succeeded.

Eroject closed

The 'close_project' command succeeded

The Execute Script command succeeded.

Generating Bitstream File Finished : Wed Sep 30 12:26:04 2015 (Elapsed time 00:01:03)

Log | Message

Figure 46 * Regenerating Remapping_Appnote_0 Component
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D Libero - CAeNVM_Multiple ImagesiliberoP

Project File Edit View Design Tools Help
=
Sull=aoB|
Jesign Flow & X

- RER

Remapping_Appnote_top

Tool
4 b Edit Design Hardware Configuration
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Remapping_Appnote_tep ...
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Remapping_Appnote MSS_.
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synplifylog
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a
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@ Remapping_Appnote t...
Remapping_Appnote_te
Remapping_Appnote_tol
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Remapping_Appnote_top..
@ Remapping_Appnote t...
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S

S
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FlashPro
Version: 11.6.0.34
Release: v1Ll.§

Software Version: 11.6.0.34
Opened

'C:/eNVM Multiple Images/LiberoProject/Remapping Appnote/designer/Remapping_Appnote_top/Remsppil

ng_Rppnote_top_fp/Remapping_Appnote_top.pro’
The 'open_project’ command succeeded.
file

79

2-2379-7£6223797562.pdb" has been loaded successfully

DESIGN : Remapping_Appnote_top; CHECKSUM : SBF2; PDB_VERSION :

The 'load programming_data' command succeeded.
The 'set_programming file' command succeeded
Project saved

The 'save_project’ command succeeded.

Project elosed.

Libero

Running PROGRAM Action. Please do not interrupt.

h

1.

SIfVM Multiple Tmages\LiberoProject\Remapping Appnote\designer\Remapping_Appnote_top\f1576=2\

9

Opened 'C:/eNVM Multiple Tmages/LibercProject/Remapping_Appnote/designer/Remspping_Appnote_top/Remapping Appnote_top_fp/Remapping Appnete_top.pro’

The 'open_project’ command succeeded.

EDB file 'C:\eNVM Multiple Images\LiberoProject\Remapping_Appnote\designer\Remapping_Appnote_tophf2576e85-e379-4162-a379-7£62e3797662.pdb" has been loaded suecessfully.
DESIGN : Remapping Appnote_top; CHECKSUM : SBF2; PDB_VERSION : 1.9

The 'load programming data’ cormand succeeded
The 'set_programming_file' command succeeded.
Project saved.

The 'save_project' command succeeded.

Eroject closed

The 'close_project' cormand succeeded

The Execute Script command succeeded.

Generating Bitstream File Finished : Wed Sep 30 12:26:04 2015 (Elapsed time 00:01:03)

Software Version: 11.6.0.34
Software Version: 11.6.0.34

Figure 47 « Programming SmartFusion2 Security Evaluation Kit

Updating eNVM Memory Content

This option is available in Libero.design flow to load the updated .hex files after compiling the application
code in SoftConsole. Without this.option, every time the SoftConsole application is built, System Builder
eNVM Configurator is required to update the eNVM client with the new .hex file generated, which may be
time consuming.

If the new .hex file generated from the SoftConsole application project is larger than the previous .hex
file, Update eNVM Memory Content throws an error. Go back to the System Builder and manually
update the Hex file.
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The following steps describe how to use Update eNVM Memory Content option:
1. Choose Update eNVM Memory Content option from Libero design flow.

o awy Comtmes *o o & e

G‘ Libero - C:\eNVM_Multiple_Images\LiberoPs i ing_#

T O T

Tools

Project  File

MEW N0

[Design Flow

Edit View Design SmartDesign  Help

8% [ Reports 5 X | StarPage @ x | Remapping_Approte_top & X ‘

B CEE Bemmr M o, QARG E AND

Remapping_Appnote_top

Tool T
Bl Programming Connectivity and Interface
& Programmer Settings
i Device /O States During Programming

4 ) Configure Security and Programming Options

Remapping_Appnote_0

4 Configure User Programming Data
B Configure Programming Recovery

4 P FAB_RESET N
DEVRST N P DEVRST_N

POWER_ON_RESET_N

@ Cenfigure Security

BB Update eNVM Memory Content
» Program Design

B Configure Bitstream

B Generate Bitstream
E: Run PROGRAM Action

<<

4 b Debug Design
8 Identify Debug Design
€ SmartDebug Design
4 b Handoff Design for Production
4 Export Bitstream
4 Expert Programming Job o

I

w

HMDDR FADS m

EGHO_FABRIC
EHMVUART 1_PADS

Design Flow | Desion Hierarchy | Stimulus Hierarchy | Catalog | Fles |

Log

[[ElMessoges | @ errors i, wamings ) nfo

Chain Programming Finished: Mon Feb 09 14:04:28 2015 (Elapsed time 00:01:59)
e-o-g-o-0-0

The 'run_selected actions' command succeeded.
The 'set_prograrming_file' comrand succeeded.
Project saved.

The 'save_project’ command succeeded.

Project closed.

The 'close project’ command succeeded.

The Execute Script command succeeded.

Log | Message

Fam: SmartFusion2 | Die: M25090T |Pkg: 484FBGA | Verilog

Figure 48 « Update eNVM Memory Content Option
2. Update eNVM Memory Content window as shown in Figure 49.

- N
D eMvMUpdateTool e o Bty LNl <ot . shen = S (2 [t
Available Client types User Clients in eNVM
Data Storage R e
Serialization Client Type Client Name Depthxitidth Start Address(Hex) Page Start Page End In
1 | Datastorage| eNvM MainApp_HexFiled 5040 % 8 0 0 3
2 || Data Storage|  eNVM_to_eSRAM_HexFile1 4576 % 8 4000 128 163
Add to System. ..
| 3 ||@ DotaStorage|  eNVMoto_eSRAM_HexFile2 4576 x 8 8000 256 291
L Statist |
sa0e S 4 @ DataStorage| eNVM_to_eSRAM_HexFle3 4576 8 12000 576 511
Available Pages: 4032
UsedPages: 222 | 5 || Datastorage| eNVM_to_eSRAM_HexFled 4576 % 8 16000 704 739
FreePages: 3310 ‘ ° ||€) DstasStorage|  eNVM_128KB_HexFies 4784 % 8 20000 1024 1061
a | i r
‘fou can disable programming for a dient by editing the dient and selecting the "No Content’ option.
The content will be preserved and programming of this dient can be re-enabled by selecting the preserved content.
B Used Space

[<

Figure 49 » Update eNVM Memory Content Window
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3. Browse through the updated .hex file, see Figure 50. Click Ok.

@)t |\ t\Remapping_Appnote\SoftConsole\Remapping_Appnote_MS5_CM3\projects\Remapping_Appnote_MS5_CM3_zpp'\Release ~ | ¢4
— - — -

Organize Include in library Share with + Burn New folder

3 Favorites Name ’ Date modified Type Size
Bl Desktop || main.d 30-09-201512:23 D File 2KB
4 Downloads || main.o 30-09-201512:23 O File 4 KB
‘=l Recent Places | makefile 30-09-201512:23 File 3KB
=] memory-map 30-09-201512:23 AML Document 1KB
7l Libraries || objects.mk 30-09-201512:23 MK File 1KB
@ Documents |_| Remapping_Appnote_MSS_CM3_app 30-09-201512:23 File 128 KB
J‘ Music |_| Remapping_Appnote_MSS_CM3_app.hex  30-09-201512:23 HEX File 15KB
[E5] Pictures || Remapping_Appnote_MSS_CM3_app.lst 30-09-201512:23 LST File 139 KB
Subversion |_| Remapping_Appnote_MSS_CM3_app.map  30-09-201512:23 MAP File 61 KB
E# videos |_| Remapping_Appnote_MSS_CM3_app.srec  30-09-201512:23 SREC File 15KB
|| sources.mk 30-09-201512:23 MK File 2KB
1% Computer || subdir.mk 30-09-201512:23 MK File 3KB

&, Local Disk (C)

—a Mew Volume (D:)

i"! MNetwork

’ 12 items

Figure 50 * Browsing through Updated Hex File

4. Update the .hex files for the remaining data storage clients.
5. Perform Run PROGRAM Action.
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Running the Design on SmartFusion2 Security Evaluation Kit

The following steps describe how to run the design:

1. Connect the FlashPro4 programmer to the J5 connector of SmartFusion2 Security Evaluation Kit.

2. Connect the host PC to the J18 connector provided on the SmartFusion2 Security Evaluation Kit
using the USB min-B cable. Ensure that the USB to UART bridge drivers are automatically
detected (can be verified in the Device Manager), as shown in Figure 51.

Note: Copy the COM port number for serial port configuration. Ensure that the COM port location is
specified as on USB Serial Converter D, as shown in Figure 51.

rﬁ Device Manager [E=EE -EZ-]

File Action View Help i
e Mol NERN ? Nl N L
4 wibd-edarap

-8 Computer 1JSB Serial Part (COME)
C e

b Disk drives e

.l Dy

S Display adapters . Device type: Ports (COM& LPT)

e DVD/CD-ROM drives .

> Human Interface Devices Manfacturer: FTDI

b g IDE ATASATAPI controllers Location: on USE Senal Converter D
> & Jungo

\
USB Serial Port (COMS) Properties ==

General | Port Settings I Driver I Detail5|

+ .2z Keyboards Device status

b ﬂ Mice and other pointing devices This device is working property. B
» B Monitors

b ¥ Metwork adapters

473" Ports (COM & LPT)

" ? Communications Port (COM1)
Y5 USB Serial Port (COM3)

Y5 USB Serial Port (COMY)

Y5 USB Serial Port (COMS)

i

"= USB Serial Port (7™ - a
Update Driver Software...
- |2} Processors

»-%| Sound, video and gi Disable
> M System devices Uninstall

b - § Universal Serial Bus OK ] [ Cancel
Scan for hardware changes

%

Opens property sheet fort Properties

Figure 51 » Device Manager Window

3. If USB to UART bridge drivers are not installed, download and install the drivers from:
www.microsemi.com/soc/documents/CDM_2.08.24_WHQL_Certified.zip.

4. Connect the power supply to the J6 connector and switch ON the power supply switch,SW7.

5. Start the HyperTerminal program with a baud rate of 57600, 8 data bits, 1 stop bit, no parity, and
no flow control. If the PC does not have HyperTerminal program, use any free serial terminal
emulation program such as PuTTY or TeraTerm. Refer to the Configuring Serial Terminal
Emulation Programs Tutorial for configuring the HyperTerminal, TeraTerm, and PuTTY.

6. Program the SmartFusion2 Security Evaluation Kit Board with the provided programming file
using the FlashPro software (Give the *.stp file path. Refer to "Appendix A: Design and
Programming Files" on page 45).

7. This step is required if *.stp file in the design folders is used. In Libero design, Run PROGRAM

Action programs the *.stp file to the Board.After successful programming, press SW6 switch to
reset the board.
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8. The serial terminal program displays the user options as shown in Figure 52.

5 Serial Output - HyperTerminal || B
Eile Edit View Call Jransfer Help

D & E DH &

#ielcome to SmartFusion? = Running HexFile@H
Select the below option

1. Run Hex Filel from eSRAM

2. Run Hex File? from eSRAM

3. Run Hex Filed from eSRAM

4. Run Hex File& from eSRAM

9. Run Hex Filed from eNVH

Figure 52 * Running Hex File - User Options

9. Select option 1 as shown in Figure 53. The application image runs from eSRAM. E1, F4 LEDs
blink on the Board.

10. Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings.the application to the
Main Menu.

File Edit View Call Transfer Help

#llelcome to SmartFusion? - Running HexFileO#
Select the below option

1. Run Hex Filel from eSRAM

2. Run Hex File? from eSRAM

3. Run Hex File3 from eSRAM

4. Run Hex Filed from eSRAM

5. Run Hex Fileb from eNYH

Running Hex Filel

EDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

LEDs Blinking

#llelcome to SmartFusion? = Running HexFileO#
Select the below option

1. Run Hex Filel from eSRAM
2. Run Hex File2 from eSRAM
3. Run Hex File3 from eSRAM
4. Run Hex Fileh from eSRAM
5. Run Hex Fileb from eNYH

Connected 0:01:14 Auto detect 57600 8-N-1 NUM

Figure 53 * LEDs Blink Based on User Option

11. Select option 2. The application image runs from eSRAM. F3, G7 LEDs blink on the Board.

12. Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

13. Select option 3. The application image runs from eSRAM. H7, J6 LEDs blink on the Board.

14. Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

15. Select option 4. The application image runs from eSRAM. H6, H5 LEDs blink on the Board.

16. Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.
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17. Select option5. The application image runs from eNVM. E1, F4, F3, G7, H7, J6, H6, H5 LEDs
blink on the Board.

18. Reset the SW6 pin on SmartFusion2 Security Evaluation Kit, which brings the application to the
Main Menu.

Conclusion

This application note describes the step-by-step approach to build single/multiple SoftConsole
application executable images in production release mode, store the executable images into eNVM using
eNVM data storage client, and execute them on SmartFusion2 Security Evaluation Kit.
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Appendix A: Design and Programming Files

You can download the design files from the Microsemi SoC Products Group website:
http.//soc.microsemi.com/download/rsc/?f=m2s_ac426_liberov11p6_df

The design file consists of Libero Verilog, SoftConsole software project, programming files (*.stp) for
SmartFusion2 SoC FPGA Security Evaluation Kit. Refer to the readme . txt file included in the design file
for the directory structure and description.
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Appendix B: Creating LookUpTable.Hex File

The LookUpTable.Hex file contains the pre-calculated factorial data and this is a non-executable image.
The following steps describe how to create the LookUpTable.Hex file:
1. Open the notepad and enter the factorial of number 2,3,4 as 2,6,24 as shown in Figure 1.

| Untitled - Notepad = | B ||
[ File Edit Format View Help |

‘2624| B

Figure 1  Entering Factorial Values in Notepad

2. Save the notepad as LookUpTable.bin as shown in Figure 2.

Save As o]
— — — =5
Q\_}-- » Computer » New Volume (Dt) » Microsemi » utilities »
Organize »  New folder =+ B
{ Favorites
[l Desktop 57 binzhex

& Downloads B binZhex

%L Recent Places

4 Libraries
*| Documents
o' Music
=) Pictures

B videos
% Computer

&, Local Disk (C)

s New Volume (0t)

File name:  LookUpTable.bin =

Save as type: | All Files |

=~ Hide Folders Encoding: | ANSI - Save | Cancel

Figure 2 » Saving Notepad

3. The executable file, bin2hex.exe converts the LookUpTable.bin, which is in binary format to
LookUpTable.Hex in Hex format. This executable file is available in the following path of the
design files provided along with this application note:
http.//soc.microsemi.com/download/rsc/?f=m2s_ac426_liberov11p6_df
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r

B C\Windows\system32\cmd.exe

All rights reserved.

D:<Microsemidutilitie
[BINZHEX Ver 1.1 HABTGS
LookUpTahle .bin

LookUpTahle .Hex
ARBA : Beae

Input hin fil
0 t UHDL fil
Load Address
Done. ...

D:<Microsemisutilitie

yinZhex.exe LookUpTable.bin LookUpTabhle.Hex

Figure 3 » Converting Binary File to Hex File

4. The LookUpTable.Hex file is generated as shown in Figure 4. This file is copied to SoftConsole

project folder of the eNVM Data client SoftConsole project.

m 0" Microserniutilities) |4y

Organize + Open Bum New folder
Favorites
B Desktop ® 1 binZhex
I & Downloads B binZhex

LookUpTable bin
LooklUpTable. Hex

Recent Places

a Libraries

=| Documents
o' Music

| Pictures

B videos
1% Computer
&, Local Disk (C:)
& New Volume (0x)
€ Network

LockUpTableHex [ 6/27/2014 4:51 PM

o
)
- 7

Figure 4 » LookUpTable.Hex File

Revision 4

47



& Microsemi

A — List of Changes

The following table shows important changes made in this document for each revision.

Date Changes Page
Revision 4 Updated the document for Libero v11.6 software release (SAR 72112). NA
(October 2015)
Revision 3 Updated the document for Libero v11.5 software release (SAR 65408). NA
(March 2015)
Revision 2 Added the bin2hex.exe file to the design files and added a link to design files in the 46
(December 2014) "Appendix B: Creating LookUpTable.Hex File" chapter (SAR 63426):
Revision 1 Initial release. NA
(August 2014)
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B — Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices.
This appendix contains information about contacting Microsemi SoC Products Group and using these
support services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060

From the rest of the world, call 650.318.4460

Fax, from anywhere in the world, 408.643.6913

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled
engineers who can help answer your hardware, software, and design questions about Microsemi SoC
Products. The Customer Technical Support Center spends a great deal of time creating application
notes, answers to common design cycle questions, documentation of known issues, and various FAQs.
So, before you contact us, please visit our online resources. lt'is very likely we have already answered
your questions.

Technical Support

For Microsemi SoC Products Support, visit
http://www.microsemi.com/products/fpga-soc/designsupport/fpga-soc-support

Website

You can browse a variety of technical and non-technical information on the SoC home page, at
www.microsemi.com/soc.

Contacting the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be
contacted by email or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email,
fax, or phone. Also, if you have design problems, you can email your design files to receive assistance.
We constantly monitor the email account throughout the day. When sending your request to us, please
be sure to include your full name, company name, and your contact information for efficient processing of
your request.

The technical support email address is soc_tech@microsemi.com.
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Product Support

My Cases

Microsemi SoC Products Group customers may submit and track technical cases online by going to My
Cases.

Outside the U.S.

Customers needing assistance outside the US time zones can either contact technical support via email
(soc_tech@microsemi.com) or contact a local sales office. Sales office listings can be found at
www.microsemi.com/soc/company/contact/default.aspx.

ITAR Technical Support

For technical support on RH and RT FPGAs that are regulated by International Traffic .in Arms
Regulations (ITAR), contact us via soc_tech_itar@microsemi.com. Alternatively, within My Cases, select
Yes in the ITAR drop-down list. For a complete list of ITAR-regulated Microsemi-FPGAs, visit the ITAR
web page.
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Microsemi.

Microsemi Corporate Headquarters
One Enterprise, Aliso Viejo;
CA 92656 USA

Within the USA: +1 (800) 713-4113
Outside the USA: +1 (949) 380-6100
Sales: +1 (949) 380-6136

Fax: +1 (949) 215-4996

E-mail: sales.support@microsemi.com

© 2015 Microsemi Corporation. All
rights reserved. Microsemi and the
Microsemi logo are trademarks of
Microsemi  Corporation. All  other
trademarks and service marks are the
property of their respective owners.

Microsemi Corporation (Nasdaq: MSCC) offers a comprehensive portfolio of semiconductor
and system solutions for communications, defense & security, aerospace and industrial
markets. Products include high-performance and radiation-hardened analog mixed-signal
integrated circuits, FPGAs, SoCs and ASICs; power management products; timing and
synchronization devices and precise time solutions, setting the world’s standard for time; voice
processing devices; RF solutions; discrete components; security technologies and scalable
anti-tamper products; Ethernet Solutions; Power-over-Ethernet ICs and midspans; as well as
custom design capabilities and services. Microsemi is headquartered in Aliso Viejo, Calif., and
has approximately 3,600 employees globally. Learn more at www.microsemi.com.

Microsemi makes no warranty, representation, or guarantee regarding the information contained herein or
the suitability of its products and services for any particular purpose, nor does Microsemi assume any
liability whatsoever arising out of the application or use of any product or circuit. The products sold
hereunder and any other products sold by Microsemi have been subject to limited testing and should not
be used in conjunction with mission-critical equipment or applications. Any performance specifications are
believed to be reliable but are not verified, and Buyer must conduct and complete all performance and
other testing of the products, alone and together with, or installed in, any end-products. Buyer shall not rely
on any data and performance specifications or parameters provided by Microsemi. It is the Buyer's
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